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1 Introduction

Acoustica is a comprehensive solution for professional audio recording, editing, mixing

and mastering. The intuitive user interface was designed with speed, accuracy and

ease-of-use in mind and gives access to a large set of powerful tools to make your

recordings sound the best. The consistent workflow simplifies your production work all

the way from recording, editing, batch processing, sound design and audio restoration

to Red Book compatible CD burning.

1.1 What is new in Acoustica Standard Edition 6

Acoustica Standard Edition 6 contains several exciting new features. The highlights are:

Multitrack audio editing

· Create as many audio tracks as you want to

· Apply effect chains to tracks or master track

· Clips can easily be looped and stretched

· Add transitions between clips by simply overlapping them in the time line. Several

transitions curves are available

· Double click a clip to open and modify the content in an audio editor window.

New processing tools

· Superb quality time stretching as previously only available in the premium edition

· Transpose tool (pitch shift) based on the new time stretching engine

· New reverb with much better control over the room and filter parameters.

· The parametric equalizer now offers six different filter types - low shelf, peak, high

shelf, high pass, notch and low pass.

Other

· Improved VST preset handling which is more consistent with how presets are

managed for the internal processing tools.

· WAVE64 – support for files bigger than 4 GB

1.2 Requirements

Before you install Acoustica Standard Edition, please make sure your computer fulfills

the following requirements:

· A Pentium IV or higher, including SSE2 support

· Minimum 256 MB RAM (1 GB recommended)

· A Windows MME or ASIO compatible sound card

· Windows 8, Windows 7, Windows Vista or Windows XP
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2 Basic Audio Editing

This chapter describes the basic audio editing capabilities of Acoustica such as loading

and saving files and editing using the clipboard or drag and drop.

2.1 The Acoustica Workspace

The Acoustica workspace can contain several audio editing windows, CD projects or

Cleaning Wizard projects. 

The Acoustica workspace

The figure above shows the Acoustica workspace with an audio editing window and a

CD project. The elements indicated with the red arrows are explained below:

1. The main toolbar with short cut icons for commonly used commands.

2. The navigation toolbar for recording, playback and cursor positioning.

3. An audio editing window containing the audio file "Matecha.wav". The audio is

visualized with a curve corresponding to the recorded audio (see Time Domain).

4. A selected region indicated with white curve on a blue background (colors depend
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on your system settings). The current cursor position is indicated by a blinking line.

5. The output level meters show the current output level during audio playback.

6. The status bar indicating the selected region, the viewed region and the cursor

position. During processing, the progress is displayed in the status bar.

7. A "CD project" window containing a list of tracks and a toolbar for commands

relevant to CD recording.

8. The list of CD tracks that are about to be recorded to an audio CD.

2.2 Loading Audio Files

To open existing audio file,

1. Select from the File menu the command Open...

2. Choose the folder in which your file is located from the Look in drop-down list.

3. Click the audio file you wish to open and click the button labelled Ok.

2.3 Saving Audio Files

To save an edited audio file with its original name:

1. Select from the File menu the command Save or press Ctrl+S.

If you wish to save the content of an audio editing window with a different name, in a

different folder or with different settings:

1. Select from the File menu the command Save as...

2. Choose the folder in which you wish to save the file from the Look in drop-down list.

3. Enter a name for your audio file.

4. Choose the file format of your audio file from the File type drop-down list.

5. Most export filters offer different settings such as encoding bit rate or number

format. To change the settings, click the button labelled Options... .

2.4 Playing a Recording

To play the selected region of a recording:

1. Select from the Sound menu the command Play or press the space bar.

2. You can stop the playback by selecting from the Sound menu the command Stop or

by pressing the space bar.

You can also play the complete recording:
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1. Select from the Sound menu the command Play all or hold the shift key while

pressing the space bar.

2. You can stop the playback by selecting from the Sound menu the command Stop or

by pressing the space bar.

To play the selected region as a loop:

1. Select from the Sound menu the command Play looped or hold the control key while

pressing the space bar.

2. You can stop the playback by selecting from the Sound menu the command Stop or

by pressing the space bar.

Alternatively, you can use the navigation toolbar for convenient playback:

The navigation toolbar with the logic similar to consumer audio equipment such as CD players or

tape decks.

2.5 Selecting Regions

Acoustica does all processing on the selected region and the selected channels only. The

selected region is highlighted. To change the selected region:

1. Click the beginning of the region you wish to select and keep the mouse button

down.

2. Move the mouse cursor to the end of the region you wish to select while keeping the

mouse button down.

3. Release the mouse button.

4. The newly selected region should now by highlighted.

2.6 Selecting Channels

Acoustica does all processing only on the selected region and the selected channels. To

change the selected channel or channels (only possible with stereo recordings):

1. Click the channel selection button in the main toolbar (see The Acoustica Workspace

): 

2. A drop-down list with the channels appears.

3. Click the channel you wish to activate or deactivate.
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2.7 Zooming and Scrolling

You can zoom in to get a more detailed view in an editing window. You can zoom either

horizontally to view a smaller part of the recording or vertically to show a smaller

amplitude range.

Horizantal zoom

To zoom in horizontally:

· Press the arrow up key

- or -

· Move the mouse wheel upwards

To zoom out for a better overview:

· Press the arrow down key

- or -

· Move the mouse wheel downwards

Note You can zoom out to view the whole recording by selecting View | View all

or by pressing Shift + A.

Scrolling

In those cases where only a part of the recording is shown, a scroll bar is visible below

the visualisation of the wave form. You can use the scroll bar to view other parts of the

recording.

Vertical zoom

To zoom in vertically:

· Press and hold the control key while pressing the arrow up key

To zoom out vertically:

· Press and hold the control key while pressing the arrow down key

You can also enter the zoom factor in the toolbar and press the enter key:
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The vertical zoom bar

2.8 Drag and Drop Editing

You can move or copy regions using so-called drag and drop editing. To move a region

to a another location in the same editing window or to another editing window:

1. Select the region you wish to move (see Selecting Regions).

2. Click the somewhere within the highlighted region and keep the mouse button

down.

3. Press the Shift key while moving the mouse cursor to the new start position and

release the mouse button.

To insert a copy of a region using drag and drop:

1. Select the region you wish to copy (see Selecting Regions).

2. Click the somewhere within the highlighted region and keep the mouse button

down.

3. Press the Ctrl key while moving the mouse cursor to the insert position and release

the mouse button.

To mix two regions using drag and drop:

1. Select the first of the regions you wish to mix (see Selecting Regions).

2. Click the somewhere within the highlighted region and keep the mouse button

down.

3. Press the Alt key while moving the mouse cursor to the start position and release the

mouse button.

Note If you press neither the Ctrl key nor the Shift key during drag and drop,

Acoustica will perform the default action which is a move operation if the

drop destination is the same editing window and a copy operation if the

drop destination is another editing window.

2.9 Editing using the Clipboard

The clipboard concept provides a common way of editing documents for all Windows

applications. You can edit your recordings by copying the selected region to the

Acoustica clipboard using the command Edit | Copy and paste the region into another

location using the command Edit | Paste Insert. The Paste Insert command is equivalent to
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the normal paste command common in most Window applications. Acoustica has offers

two additional ways of pasting:

· Paste Overwrite, which substitutes a selected region with the content of the

clipboard.

· Paste Mix, which mixes the selected region with the content of the clipboard.

The command Edit | Cut copies the selected region to the clipboard before deleting it

from the source recording. For the purpose of deleting parts of the recording, use one of

the following two commands:

· Delete, which deletes the selected region

· Crop, which deletes everything but the selected region.

2.10 Audio Scrubbing

Sometimes it is hard to find a specific part of a recording using the visualization only.

The audio scrub mode simplifies the search by giving aural feedback while you can

move the playback position using the mouse. To use the audio scrubbing:

1. Enable the audio scrubbing mode clicking the audio scrubbing symbol in the toolbar

(  ) or by pressing A.

2. Click the left mouse button and keep it down while moving the mouse cursor

3. Release the mouse button when you have found the part you were searching for.

4. Enable the selection mode by clicking the selection mode symbol in the toolbar (  )

or by pressing S.

2.11 Labels and Regions

You can simplify the editing process by inserting anchors such as labels and regions to

your recording.

Adding Labels

To add a label to the recording:

1. Move the cursor position to where you want the to insert a label

2. Click the right mouse button and select "Add Label..." or press L.

3. A label appears at the cursor position
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Note You can press Ctrl + L to add a new label and directly open a dialog box to

give it a name.

Adding Region Markers

To add a region marker to the recording:

1. Select the part of the recording where you want a region marker

2. Click the right mouse button and select "Add Region..." or press R.

3. A region is appears at the selection

Note You can press Ctrl + R to add a new label and directly open a dialog box to

give it a name.

Renaming, Moving and Deleting Anchors

You can easily rename anchors:

1. Double click the anchor text

2. A properties dialog box appears.

3. Enter the new name of the anchor.

4. Click the button labelled OK.

You can also move the anchors:

1. Click the left mouse button at the upper part of red line visualizing the anchor.

2. Keep the mouse button down while moving the anchor to its new position

3. Release the mouse button.

To delete an anchor:

1. Click the right mouse button at the anchor text

2. A context menu appears.

3. Select "Delete"

The Label and Region List Windows

You can edit and keep track of your anchors by showing the region list and label list

windows. To show the label list window, select "Label List" from the View menu. The

menu item "Region List" from the same menu shows the region list.



12 Acoustica User Guide

Copyright © 2013 Acon AS

The Region and Label List windows make it easy to edit and keep track of the anchors.

2.12 Adding Loops for MIDI Samplers

Audio files in the WAVE format can contain specialized loop information for MIDI

Samplers and software samplers. Acoustica supports this standard and you can add

loops and define the base note and fine tuning of the recorded sample. To add a sample

loop, selected Edit | Add Sampler Loop... or press "O". The Add Sampler Loop dialog box

appears:

The Add Sampler Loop dialog box.

You can specify an infinite loop that is repeated until the MIDI note is released or a

specific loop count. Acoustica also allows you to crossfade the ending and the beginning

of the loop to avoid click sounds at the loop edge. Add a check mark to the Enable

Crossfading check box to enable the cross fading. You can specify the percantage of the

loop duration that is used for cross fading.
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The information in Global MIDI Sample Settings is not stored for each loop, but are global

settings for the complete recording. You can edit these settings when adding loop,

because loop and note with fine tuning information is usually required when creating

loops for MIDI samplers. However, you can also change these parameters in the Tempo

and Key tab of the recording properties  (File | Edit Properties...).

2.13 Using Analyzers

The integrated analyzers allow you to analyze the output audio signal in real time

during playback. You can hide or show the analyzers by choosing View | Analyzers and

selecting one of the analyzers from the sub menu.

2.13.1 Level Meter

The level meter lets you analyze the output level in terms of peak, peak hold and RMS

values. The peak value is the maximum sample within a short analysis interval and is

the value defining the height of the level meter bars. The peak hold value is the

maximum sample level over a longer period of time. It is indicated as a white line above

or at the top of the level meter bar. RMS stands for root-mean-square and is calculated

by the root of the sum of the squared sample values during the analysis interval.

The level meter analyzer showing the peak hold value (1), peak value (2) and RMS value (3).

You can configure the level meter to use different scales or change ballistics by clicking
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the left mouse button somewhere in the level meter. The following dialog box appears:

The settings dialog for the level meters.

Acoustica supports the K-System metering standard proposed by the audio engineer

Bob Katz. The K-System an attempt to standardize leveling practices throughout the

audio industry. Three standards are available, K-20, K-14, and K-12 which are intended

for different listening environments. You can choose to use one of the K-System meters

or use the digital full scale meter as in earlier version of Acoustica.

2.13.2 FFT Analyzer

The FFT Analyzer shows the frequency content of short analysis time frames. FFT stands

for Fast Fourier Transform. FFT is an efficient way of calculating the frequency domain

of a signal. For more information about the frequency domain, please see Frequency

Domain.

The FFT Analyzer shows the frequency content of the output audio signal.

2.13.3 Phase Correlation Meter

The phase correlation meter shows the phase relationship between the left and the right

audio channel in a stereo recording and is an important tool when mastering stereo

recordings. If both channels contain exactly the same signal, the phase correlation meter

will show a vertical line. If one channel is exactly the opposite of the other channel, the

phase correlation meter shows a horizontal line. Normal stereo recordings will show a
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cloud of dots spread out vertically and horizontally (see the picture below). In a

properly mastered recording, the cloud of dots should not be wider than it is tall.

The phase correlation meter shows the relationship between the left and the right channel in a

stereo recording.

2.13.4 Big Time Display

The big time display shows the current playback position in a resizable and dockable

window.

3 Multitrack Audio Editing

New in Acoustica 6 is the ability to edit multitrack audio. An arbitrary number of audio

tracks can be created which are mixed in real-time during playback. Each track contains

can contain multiple audio clips.

3.1 Creating a Multitrack Session

To create a new multitrack session, choose New | Multitrack Session... from the File menu.

A dialog box appears where you can enter the name of the project, the folder location,

audio formats and other session specific settings:
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The "New Session" dialog in Acoustica with different settings.

Acoustica will create a subfolder with the name specified in Session folder name in the

folder defined in folder location. Clips that are recorded or modified in the multitrack

editor will be placed in this folder along with the session file itself.

Choose OK when you have entered a session name and are ready to create the

multitrack session window. The new multirack session window now shows up in

Acoustica containing a single audio track:
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The newly created multitrack session as shown in Acoustica

3.2 Working with Tracks

Adding Tracks

To add a new track, choose Insert new Track from the Session menu. A new track will

appear after the selected track.

Removing Tracks

To remove a track, click the track you want to remove in the multitrack editor to select it.

Then choose Delete Selected Track from the Session menu.

Track Settings

You can change the volume and see the current playback level directly from the track

pane on the left side in the multitrack editor:

The track pane with volume control and level metering as well as record, solo, mute and settings

buttons

You can also choose to mute or listen to a single track (solo) during playback. To listen to

a single track during playback, click the solo button:

To mute one or more tracks during playback, activate the mute by clicking the mute

button:
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To edit further track settings such as track title, panning, track effects, click the track

settings button:

Now the track properties dialog shows up. You can change the title and pick a color of

the track.

The track properties dialog lets you add effects, change track names and colors and adjust the

panning of the track

Panning

A two dimensional surround pan control in the track properties dialog lets you set the

panning. For two channel stereo, only the horizontal position position is regarded. If you

render for 5.1 or 7.1 surround projects (only available in Acoustica Premium Edition),

you can also set amount of signal to be assigned to the front or rear channels.

It is also possible to assign the output of a track to a single channel by clicking one of the

shaded rectangles representing the loudspeaker positions or the "wave" representing the

LFE (Low-Frequency Effects channel).

Effects

You can add one or more audio effects to tracks (or the master track) in a multitrack

session. Internal effects and processing tools as well as plug-ins can be added. To add an
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effect, click the Add button and choose the desired effect. To remove an effect, use the

Remove button. Double clicking an effect in the effect list or clicking the Edit button

opens the effect settings dialog so that you can adjust the effect parameters.

3.3 Adding Clips

Adding an Existing Audio File

To add an existing audio file as a clip in the multitrack session, you can simply double

click the location where you want to add the clip. A file open dialog appears where you

can choose the file you want to insert. Alternatively, you can use the file browser pane in

Acoustica and add clips using drag and drop to the multitrack session.

Recording Clips

To record a new clip, click the record button located on the left side of the multitrack

editor window:

A new clip will now be recorded and at the same time you will hear the audio from

other tracks in the session. The clip will use the same resolution and sample rate as

defined as rendering format of the session. You can choose to record either mono or

stereo clips from the Session Settings... under the Options menu.

3.4 Looping and Stretching Clips

You can change the duration of clips either by looping or stretching the content. To loop

or set the duration shorter than the content of the clip, press and hold the left mouse

button on the upper part of the right clip border where the loop symbol is displayed ( ).

When you move the cursor to the left or to the right, the sound clip is shortened or

extended. When you release the left mouse button, the clip length is fixed. In addition,

when you extend the clip you can see that the repeating sequences are always colored

alternately light and dark. 

As mentioned, you can also stretch the clip to match the duration or tempo of the

project. This involves processing the clip content with the time stretching algorithm in

Acoustica. The procedure is the same as for looping, but press and hold the left mouse

button on the lower right border of the clip where the stretch symbol is displayed ( ).
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3.5 Moving and Grouping Clips

You can move a clip in time or to another track by pressing and holding down the left

mouse button. Now move the clip to its new location in time or another track. If you

want to move several clips, you can use the hold down the Ctrl button on your keyboard

while clicking the clips you want to move with the left mouse button. Release the Ctrl

button when done. The clips are are now highlighted and you can use the same

procedure as for single clips to move the group of clips.

Grouping Clips

If you have a set of clips that should always be moved together, you can group clips so

that they will always be moved together. Highlight the clips you want group using the

procedure described above and choose Group from the Session menu. To ungroup,

simply click one of the clips in the group to highlight all the clips and choose Ungroup

from the Session menu.

3.6 Crossfading Clips

You can easily crossfade clips in a multitrack session. Press and hold down the left

mouse button on a clip and move it so that it overlaps the clip it should be crossfaded

with. The crossfaded region is shaded and the fade-in (red) and fade-out (blue) curves

are visually indicated:

Crossfaded clips in the multitrack editor. Click the transition region to modify the fade curves.

To choose different fade curves, click the shaded transition region and a pop-up menu

appears where you can choose between a set of predefined crossfade characteristics.

3.7 Saving, Loading and Exporting

You can save and load multitrack sessions similar to saving and loading or ordinary

audio files in Acoustica.

Loading Multitrack Session Files

To open an existing multitrack session file,

1. Select from the File menu the command Open...

2. Choose the folder in which your file is located from the Look in drop-down list.
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3. Click the multitrack session file you wish to open and click the Ok button.

Saving Multitrack Session Files

To save the content of a multitrack session with its original name:

1. Select from the File menu the command Save or press Ctrl+S.

If you wish to save the content of a multitrack session with a different name, in a

different folder or with different settings:

1. Select from the File menu the command Save as...

2. Choose the folder in which you wish to save the file from the Look in drop-down list.

3. Enter a name for your multitrack session file and click the Ok button.

Exporting Audio Files from Multitrack Sessions

You can save the rendered audio from a multitrack session as an audio file:

1. Select from the File menu the command Export to Audio File...

2. Choose the folder in which you wish to save the file from the Look in drop-down list.

3. Enter a name for your audio file.

4. Choose the file format of your audio file from the File type drop-down list.

5. Most export filters offer different settings such as encoding bit rate or number

format. To change the settings, click the button labelled Options... .

4 Connecting Your Stereo Equipment

This chapter describes how to connect your tape deck (cassette tape player) or your

record player to your computer.

4.1 Connecting a Tape Deck (Cassette Tape)

If you have an external tape deck or a compact stereo system, it will probably have so

called "RCA connectors" on the backside labelled Line Out, Tape Out or Tape Rec, as

depicted below:
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RCA connectors on a tape deck unit. Connect the sound card to the Line Out connector (1).

The Line Out of the tape deck or stereo system will now need to be connected to the

computer. Integrated sound cards are usually equipped with "mini jack" connectors (also

called 3,5 mm jack).

The back pane of a computer with an integrated sound card and a line in mini jack connector (1).

Connecting to a Sound Card with Mini Jack Connector

If you computer has mini jack connectors, a connection cable with a mini jack connector

on one end and RCA connectors on the other end is required to connect your tape deck

or stereo system to your computer.

A connection cable with RCA connectors on one end and a mini jack connector on the other.
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If you didn't receive such a cable with your sound card or computer, you can purchase

one in normal audio or electronics stores.

To connect your tape deck or stereo system, connect the end with the RCA connectors to

the Line Out, Tape Out or Tape Rec connectors on your tape deck or stereo system.

Connect the other end to the Line In connector of your computer. The Line In connector is

either labelled as such or indicated with the following symbol: .

Connecting to a Sound Card or USB Audio Device with RCA connectors

External USB devices for audio input and output are growing in popularity and many of

these have normal Line In RCA connectors.  In rare cases, internal sound cards might

also have RCA connectors.  In these cases, a connection cable with RCA connectors on

both ends is required.

A connection cable with RCA connectors on both ends.

You can purchase RCA connection cables in normal audio or electronics stores if you

don't have one already. In this case, all you have to do is connect the cable to the Line

Out, Tape Out or Tape Rec connectors on your tape deck or stereo system and the Line In

connectors of the sound card.

4.2 Connecting a Record Player (LP)

If you have a stereo system with an amplifier already set-up, the easiest way to connect a

record player to your computer is to connect the computer to the amplifier's Line Out

connectors (sometimes also labelled Tape Out, Tape Rec or Rec Out).
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RCA connectors on an amplifier. Make sure the record player is properly connected to the phono

input (1) and connect the sound card to the Rec Out connector (2).

4.2.1 Connecting a Record Player through an Amplifier

Before you proceed, please make sure your record player is properly connected to your

amplifier and that you can listen to records on your stereo system.

The Line Out of the amplifier or stereo system will now need to be connected to the

computer. Integrated sound cards are usually equipped with "mini jack" connectors (also

called 3,5 mm jack).

The back pane of a computer with an integrated sound card and a line in mini jack connector (1).

Connecting to a Sound Card with Mini Jack Connector

If you computer has mini jack connectors, a connection cable with a mini jack connector

on one end and RCA connectors on the other end is required to connect your amplifier

or stereo system to your computer.
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A connection cable with RCA connectors on one end and a mini jack connector on the other.

If you didn't receive such a cable with your sound card or computer, you can purchase

one in normal audio or electronics stores.

To connect your amplifier or stereo system, connect the end with the RCA connectors to

the Line Out, Tape Out or Tape Rec connectors on your amplifier. Connect the other end to

the Line In connector of your computer. The Line In connector is either labelled as such

or indicated with the following symbol: .

Connecting to a Sound Card or USB Audio Device with RCA connectors

External USB devices for audio input and output are growing in popularity and many of

these have normal Line In RCA connectors.  In rare cases, internal sound cards might

also have RCA connectors.  In these cases, a connection cable with RCA connectors on

both ends is required.

A connection cable with RCA connectors on both ends.



26 Acoustica User Guide

Copyright © 2013 Acon AS

You can purchase RCA connection cables in normal audio or electronics stores if you

don't have one already. An In this case, all you have to do is connect the cable to the Line

Out, Tape Out or Tape Rec connectors on your amplifier or stereo system and the Line In

connectors of the USB audio device.

4.2.2 Connecting a Record Player Directly

It is usually not possible to connect a record player directly to the computer, because the

audio on LP records is modified for technical reasons so that low frequencies (bass) are

too soft and high frequencies (treble) too loud. Amplifiers with a phono input modify

the signal using an exactly tuned equalizer so that the original signal is restored. It is

also possible to purchase hardware units solely for this purpose. These are usually called

phono preamplifiers.

The good news is that you with Acoustica 4 probably don't need any additional

hardware. Acoustica 4 emulates the equalizer in phono preamplifiers and thus restores

the original audio. You can connect the record player directly to the Line In on your

sound card and enable the Emulate phono preamplifier option in the recording page (see

Record Audio for more information).

In most cases, the record player will have "RCA connectors" on the backside labelled 

Phono, as depicted below:

RCA connectors on a record player.

Some record players come with a fixed cable with male RCA connectors:
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Cable with male RCA connectors.

The output from your record player will now need to be connected to the computer.

Integrated sound cards are usually equipped with "mini jack" connectors (also called 3,5

mm jack).

The back pane of a computer with an integrated sound card and a line in mini jack connector (1).

Connecting to a Sound Card with Mini Jack Connector

If you computer has mini jack connectors and your record player female RCA

connectors, a connection cable with a mini jack connector on one end and RCA

connectors on the other end is required to connect your record player to your computer.

A connection cable with RCA connectors on one end and a mini jack connector on the other.
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If you didn't receive such a cable with your sound card or computer, you can purchase

one in normal audio or electronics stores.

To connect your record player, connect the end with the RCA connectors to the Phono

Out connectors on your record player. Connect the other end to the Line In connector of

your computer. The Line In connector is either labelled as such or indicated with the

following symbol: .

If you record player has an integrated cable with male RCA connectors you will need an

RCA to mini jack adapter (available in audio or electronic stores), as depicted below:

An RCA to mini jack adapter.

The mini jack end of the adapter can be connected to the Line In connector of the sound

card as already described.

Connecting to a Sound Card or USB Audio Device with RCA connectors

External USB devices for audio input and output are growing in popularity and many of

these have normal Line In RCA connectors.  In rare cases, internal sound cards might

also have RCA connectors. In these cases, a connection cable with RCA connectors on

both ends is required if the record player doesn't have a cable with male RCA

connectors attached.

A connection cable with RCA connectors on both ends.
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You can purchase RCA connection cables in normal audio or electronics stores if you

don't have one already. An In this case, all you have to do is connect the cable to the 

Phono connectors on your record player and the Line In connectors of the USB audio

device.

5 Recording

Recording audio in Acoustica is easy, but there are some terms you should know before

starting you first recording project. The chapter Concepts of Digital Audio theoretically

describes some important issues regarding digital audio. If you are familiar with digital

audio, please proceed to Recording through the Sound Card.

5.1 Concepts of Digital Audio

Before audio can be edited on computers it must be digitized. The output from most

audio equipment such as tape recorders, microphones or record players is analog.

Analog means that the audio signal is represented by an alternating electrical voltage.

The voltage is analog to the air pressure changes in the air during the performance,

hence the term analog signals. The sound card in your computer is needed to convert

the constantly changing electrical voltage to a stream of numbers at fixed rate intervals. 

This process is done in two steps called sampling and quantization.

5.1.1 Sampling

The conversion from a continuously changing measure to a series of measured values at

discrete time instances is called sampling. The rate (or number of measurements per

second) of which the sampling is done, is along with the quantization depth the most

important quality factor of digital recording equipment. If it is set too low, disturbing

artifacts occur. A CD quality recording is recorded with a sampling rate of 44 100

samples per second. We say that the sampling frequency is 44 100 Hertz (or short Hz).

In fact, all frequencies above half the sampling frequency, which is known as the

Nyquist frequency, are substituted by frequencies below the Nyquist frequency. This

effect is called aliasing. To avoid aliasing a sampling system contains of a low pass filter

which ideally filters out all frequencies above the Nyquist frequency and leaves all

frequencies below unaffected. In the case of the audio CD, the highest frequency that

can theoretically be recorded is 22 050 Hz.

5.1.2 Quantization

After measuring an analog input signal at fixed time intervals we have a stream of

samples. The samples exist in terms of a voltage measured at a certain point in time. The

voltage can usually be one of an infinite number of possible voltages within the legal
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voltage range. Computers cannot accurately describe every single one of the infinite

number of possibilities, so it is necessary to divide the voltage range of interest into fixed

sized regions. All voltages within one region are given a certain number during the

quantization process. If we have a large number of regions which implies a larger

number of discrete voltage levels, we can describe a voltage more accurately than with

fewer voltage levels. The audio CD is quantized with 65536 voltage levels, which is the

maximum number of levels possible to archive with a binary number with 16 bits. Thus

we say that the Audio CD has 16 bit resolution. Modern recording studios are frequently

using 24 bit resolution or even higher during the mastering process.

The digital representation of a sine wave.

5.1.3 The Decibel Unit (dB)

When the volume of the recorded sound is changed, the degree of change is usually

expressed in terms of decibels or short dB.  This is a common unit in connection with

audio.  In Acoustica, decibel is used to express the extent of change relative to the

original level.

Special for the decibel unit is that it is based on a logarithmic scale. Zero dB represents

no change, whereas an increase of six dB represents a doubling of the signal amplitude. 

Reducing by six dB results in half the signal amplitude.

 

The decibel dB versus intensity change in percent

The decibel scale is chosen to suit the sensitivity curve of the human ear which have the

same logarithmic property.
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5.2 Recording through the Sound Card

Please follow the steps below to record audio from audio equipment such as record

players, tape decks or microphones through your sound card:

1. Make sure the audio source is properly connected to the audio input of your

computer. See Connecting Your Stereo Equipment for more information about how

to connect your audio equipment.

2. Create a new an empty recording window by selecting File | New... or position the

cursor where you want to insert recorded audio in an existing recording.

3. Select Sound | Record... or press Ctrl+R.

4. If you are recording to an empty editing window Acoustica needs to know what

sample format you wish to use (see Concepts of Digital Audio for more information).

The following dialog box appears:

 

The sample format dialog box in Acoustica

Please choose the desired recording format and click the button labelled Ok.

5. The Recording dialog box now opens:
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The Recording dialog box

Now make sure that the correct input line is selected in the line in combo box (1).

You can monitor the input level using the level meters (2) and, if needed, adjust the

input level using the input level slider (3). The level meter should never be in the red

area in order to avoid clipping distortions.

6. Click the button labelled Record (4) to start the recording.

7. When you are done recording, click the button labelled Keep (5) to accept the

recording.

5.2.1 Timer Record

The timer record feature allows you to start and stop recording after a certain period of

time or depending on the presence of an input signal. To start timer record, click the

button labelled Timer Record in the recording dialog. The following dialog box appears:
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The Timer Record settings.

You can choose to start the recording immediately (after clicking the Start Timer Record

button), at a certain time and date or when an input signal is present. The threshold

value for the input signal detection can be defined using the Silence Threshold field at the

bottom of the dialog.

The recording can also be stopped automatically, either after a certain period of silence

or after a certain period of time.

5.2.2 Advanced Recording Options

The recording dialog in Acoustica also offers some advanced settings:

The advanced recording options in the recording dialog

· Remove DC Offset

A DC offset (Direct Current offset) is present in the input signal when the audio

signal isn't centered around the zero voltage line as it should be. The problem is
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quite common on low-end sound cards. DC offset are unwanted and harmful to the

stereo equipment and it can lead to problems when processing the recording further.

You can automatically remove the DC offset by enabling the option Remove DC Offset

. Extremely low and inaudible frequency components (including the DC offset) are

then filtered out of the signal.

· Emulate phono preamplifier

This option should only be enabled when recording from a record player that is

connected directly to the input of the sound card without a phono preamplifier.

· Listen to input (digital monitoring)

You can listen to the signal being recorded (after DC offset and phono preamplifier

processing, if enabled) by enabling this option. It is not recommended to leave this

option on during the complete recording session, because it makes recording glitches

more probable.

6 Audio Processing

In Acoustica, all the processing tools have some properties in common. The processing is

performed on the selected region and the selected channels only. Furthermore, most

tools offer a preset manager that allows you to save often used parameter settings for

later use.

 

The Preset Manager found in most of the processing tools in Acoustica

To add a preset:

· Click the button labelled More...

· A drop down menu appears. Select Add Preset... from the menu.

· In the pop-up dialog, enter the name of the preset and click the button labelled OK.

Loading a preset is equally simple. Just select the preset from the drop-down list and the

preset settings are loaded. User presets can be removed by clicking the button labelled 

More..., selecting Remove Preset... and selecting the preset you wish to remove.

You can bypass the effect processing by checking the check box labelled Bypass transform

for a convenient A / B comparison.

The processing tools introduce some custom controls that you should get familiar with.

The level slider is similar to the Windows track bar, but with some enhancements. The

value range and the current value is always displayed. You can manually edit the value
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by pressing the space bar when the control is active or by clicking the value text below

the level slider. An edit box pops up containing the current value. To change the value,

enter a new value and press return. By pressing the Esc key the changes are discarded.

Examples of knobs (1) and level sliders (2).

The knob control is similar to the level slider, but it is round and is often used to save

space in complex layouts. As with the level sliders, you can change the value by pressing

the space bar or by clicking the value text below the knob.

A more complex custom control is the curve control which is used when a curve input is

needed. The curve control allows the user to add, move or remove points. Straight lines

between the points build the curve. You can add points by clicking the location where

you want a new point to appear in the curve control. You can remove points by clicking

the right mouse button over an existing point.

Examples of a curve edit control.
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6.1 Manipulating Volume

The Volume menu contains several commands for manipulation the volume of a

recording.

· Adjusting the Volume

· Normalize

· Applying a Volume Curve

· Fading In or Out

· The Channel Mixer

6.1.1 Adjusting the Volume

The most basic volume manipulation command is the Adjust Volume... command in the

Volume menu. The only parameter is the volume change in decibel. For more

information on the decibel unit,  see The Decibel Unit (dB).

The Adjust Volume settings

6.1.2 Normalize

The Normalize... command in the Volume menu can be used to ensure a constants signal

level in all your audio recordings. You can choose to normalize either the peak or the

RMS level. After selecting your desired maximum peak or RMS output level in decibel,

Acoustica analyses the selected region for the loudest peak or the overall RMS level. The

volume of the region is changed according to the selected level. If you set the normalize

level to 0 dB and use peak level normalization, the loudest part will be the maximum

level reproducible without signal distortion. For more information on the decibel unit,

see The Decibel Unit (dB).



37Audio Processing

Copyright © 2013 Acon AS

The Normalize dialog box

6.1.3 Applying a Volume Curve

You can apply a user drawn volume curve on the selected region by selecting Draw

Freehand Volume Curve... from the Volume menu.

The Volume Curve settings

6.1.4 Fading In or Out

If you wish to create fade ins or fade outs, select Fades... from the Volume menu. You can

select a fade curve from one of four mathematical functions from the Fade function

drop-down list:

· Linear

· Logarithmic

· Exponential
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· Sinusoidal

Select the direction of the fade using the Fade in or Fade out radio buttons. The resulting

fade curve is visualized in the curve control.

The Volume Fade settings

6.1.5 The Channel Mixer

The channel mixer is a tool that works only on stereo recordings. The channel mixer

mixes the content of the left and the right channels with a user defined weighting. The

weightings are individually adjustable for each channel.

The Channel Mixer settings



39Audio Processing

Copyright © 2013 Acon AS

6.2 Audio Effects

6.2.1 Dynamic Processor

A dynamic processor is used to alter the dynamic properties of the recording. To

understand how a dynamic processor works, imagine a sound engineer trying to

maintain an as steady volume level as possible while doing a recording. When the input

level increases he pulls down the volume slider, and he pulls it up when the input level

decreases. A dynamic processor does the same thing automatically, only with a much

faster reaction time.

The Dynamic Processor settings

Settings

· An editable curve containing the output level as a function of the input level. By

altering this curve you can change the dynamic characteristics of the recording to fit



40 Acoustica User Guide

Copyright © 2013 Acon AS

your needs.

· Attack time

The reaction time when the input level of the source material increases. 

· Release time

The reaction time when the input level of the source material decreases. 

6.2.2 Limiter

Limiters belong to the dynamic processing tools and ensure that the signal level doesn't

exceed a user selectable boundary while minimizing any possible distortions. To achieve

this, limiters introduce a certain latency, called look-ahead. The look-ahead ensures that

the limiter can respond in time when the signal level suddenly rises. Many CD

producers also use limiters to push the perceived volume to a maximum without

introducing audible distortions.

The Limiter settings

Settings

· Threshold

All signals above the threshold level will be attenuated so that the threshold level is

not exceeded.

· Output Gain

The output gain of the limiter which corresponds to the highest possible output

signal level.
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· Release time knob

You can use the release time knob to adjust the response time when the input level of

the source material decreases. Longer release times will result in a smoother sound.

· Look ahead knob

You can adjust the number of milliseconds the limiter uses to determine its internal

gain settings with the look-ahead knob. The limiter will have a latency equal to the

look ahead time.

6.2.3 Echo

The echo effect adds delays or echoes to the selected region. 

The Echo settings

Settings

· Echo time

· Feedback

The feedback percentage specifies the volume attenuation since the last delay

interval.

· Dry Level

The amount of unprocessed signal in the output mix.

· Delay Level

The amount of processed signal in the output mix.
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6.2.4 Reverb

About Reverberation

Reverberation occurs when sound is produced in an enclosed acoustical environment.

Even outdoors, there is likely to be some level of reverberation, however subtle. The

sound propagates through the air before it arrives at the listener, but the sound is also

reflected when it hits the walls. Due to the propagation time, these reflections arrive at

the listener later than the sound from the direct path. There are usually so many

reflections that no distinct echoes are distinguishable, but rather a smoothly decaying

sound.

The first reflections, usually called early reflections, are important cues for our

perception of an acoustical environment. For that reason, most digital reverberation

units differentiate between early reflections and the dense reverberation. The early

reflections are simulated by a small number of non-repeating echoes, whereas a complex

network of delays simulates the dense reverberation, with feedback coefficients

carefully calculated to match the reverberation time (acoustic size) of a room.

An important tool when analyzing the reverberation of real rooms is the echogram, also

known as impulse response. Playing a short impulsive sound and recording the

resulting reverberation creates an echogram. Below is an example of an echogram with

early reflections and dense reverberation.

User Interface
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The Reverb settings

Parameter Settings

· Reverberation time slider

You can use the reverberation time slider to adjust the reverberation time of the

dense reverberator. The reverberation time is specified by the number of seconds

before the reverb tail (fall-off) drops below 1/1000 (or 0.001) of its initial amplitude.

· Pre-delay slider

The pre-delay slider allows you to adjust the time before the dense reverberation

begins.

· Input filter graph

You can use the input filter graph to apply filtering on the input signal of the early

reflections simulator and the reverberation module. The frequency response of the

input filter is visualized by the blue curve. The filter consists of a low and a high

shelving filter. To adjust the filter cutoffs and gains, click the circle labeled "1" for the

high pass filter or "2" for the low pass filter and keep the mouse button down while

moving the mouse cursor. 

· High frequency damping knob
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High frequencies decay faster than low frequencies when sound propagates through

air. You can adjust the level of high frequency damping using the high frequency

damping knob.

· Room size knob

Use the room size knob to adjust the size of the simulated acoustic environment. It is

important that the room size matches the reverberation time. In open air, small

rooms have shorter reverberation times than large rooms. If the two parameters are

mismatched, the reverberation will not sound natural. However, this unnatural

sound may be an effect that's desirable for your particular program content.

· Dry level slider

The amount of unprocessed signal in the output mix.

· Early reflections slider

The amount of early reflections in the output mix.

· Reverb level slider

The amount of dense reverberation in the output mix.

6.2.5 Convolution Reverb

The convolution reverb can be used to apply recorded impulse responses from real

acoustic spaces. The impulse response file can be of any format supported by Acoustica.

Click the button Load impulse response to load an impulse response file. After loading an

impulse response file, the signal level in dB over time is displayed in the curve edit

control.
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The settings page of the Convolution reverb

Settings

· Dry level slider

The amount of unprocessed signal in the output mix.

· Reverb level slider

The amount of dense reverberation in the output mix.

· Volume curve

You can modify the fade out characteristics of the reverb using the curve edit

control.

6.2.6 Flanger

Flanger is an artificial effect. Flanger will occur when two sources playing the exactly

same recording with a short time delay are mixed together.  The result is that some

frequencies are canceled, while others are amplified. Changing the time delay between

the two sources will result in other frequencies being canceled or amplified.

The Flanger settings

Settings

· Modulation depth

Amplitude of the modulating function.
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· Modulation frequency

Frequency of the modulation function. A higher modulation frequency will result in

faster changes in the tone quality.

· Feedback

The feedback percentage specifies attenuation in the internal delayed feedback loop.

· Stereo Flanger

Toggles stereo or mono processing mode.

· Dry Level

The amount of unprocessed signal in the output mix.

· Flanger Level

The amount of processed signal in the output mix.

6.2.7 Chorus

Chorus adds warmth to recordings by dividing the audio source into several voices with

a random vibrato. These artificially created voices are then mixed together.

The Chorus settings

Settings

· Modulation depth

Amplitude of the modulating functions.

· Modulation frequency
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Frequency of the modulation functions. A higher modulation frequency will result in

faster changes in the tone quality.

· Feedback

The feedback percentage specifies attenuation in the internal feedback loop.

· Stereo Chorus

Toggles stereo or mono processing mode.

· Dry Level

The amount of unprocessed signal in the output mix.

· Chorus Level

The amount of processed signal in the output mix.

6.2.8 Distortion

The Distortion effect distorts the recording using a simulation of an electric guitar

amplifier.

The Distortion settings

Settings

· Drive

You can adjust the input gain of the distortion unit using the drive parameter.

· Fuzz

The fuzz parameter lets you adjust the fuzz level from 0 to 100%.
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· Output Level

The output level lets you adjust the output gain from the distortion unit.

· Lowpass cut-off

The output of the distortion unit is processed with a low pass filter. You can adjust

the cut-off frequency of the output filter.

6.2.9 Harmonizer

The harmonizer mixes several pitch shifted voices to create interesting harmonies. You

can mix up to four pitch shifted voices. The often experienced "chipmunk" effect which

occurs when transposing the human voice or musical instruments can be reduced using

the Maintain timbre option. When Maintain timbre is checked, Acoustica creates a smooth

spectral envelope estimation of the signal and whitens the signal before pitch shifting.

The original smooth spectral envelope is applied after transposing and the original

timbre is preserved.

The Harmonizer settings.

Settings

· Activate

Check this to activate the current voice.

· Interval

The musical interval to transpose. Use the radio buttons to set the transpose

direction to up or down.
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· Fine tune

With this slider you can fine tune the pitch shift factor in cents which are 1/100 of a

semitone.

· Volume

Volume of the current voice in dB.

· Pan

Left / right panning of the current voice in percent.

6.2.10 Transpose

The transpose command allows you to change the pitch of a recording, with or without

changing the tempo. In many cases, large pitch changes lead to unnatural sounding

results. The effect is especially pronounced when changing the pitch of the human voice,

where higher pitched voices sound more like Disney's chipmunks than a human voice.

Transpose has an optional "maintain timbre" option that reduces this artifact.

The Transpose settings

You can define the pitch change by selecting the desired interval and choosing the

direction using the "up" and "down" radio buttons. The output pitch can be fine tuned by

moving the "fine tune" slider with the mouse. The fine tuning is specified in Cents,

where 100 Cents equal one semitone.

The pitch can be changed by playing the recording faster or by using the time scale

modification engine so that the original tempo is preserved. You can activate the time

scale modification engine by checking "Maintain duration".

To activate the timbre preservation, check "Maintain timbre".



50 Acoustica User Guide

Copyright © 2013 Acon AS

6.2.11 Time Stretching

The time stretching command in Acoustica allows you to change the length of the

recording without changing the perceived pitch.

User Interface

The desired duration can be specified as a percentage of the original duration, by

specifying the original and the target duration or by specifying the original and the

target tempo in beats per minute (BPM).

Specifiying the Duration Change in Percent

You can change the duration change in percent by moving the percentage slider with the

mouse. If the percentage is set to 100%, there will be no change, whereas values higher

than 100% slow down and values below 100% speed up the recording.

You can define the percentage numerically (using the keyboard) by clicking the number

right to the percentage slider.

Specifiying Original and Target Duration

If you want the recording to match a given amout of time, you can enter the original and

the target duration. Acoustica will then calculate the correct time scaling. Both the

original and the target duration must be entered in the following format:

Hours : Minutes : Seconds : Milliseconds

Thus, a duration of 3 minutes, 45 seconds and 10 milliseconds should, for example, be

entered as 00:03:45:010.

Specifiying Original and Target Tempo

If you want the recording to match a tempo specified in beats per minute (BPM), you can

enter the original and the target tempo. Acoustica will the calculate the correct time

scaling.
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6.2.12 Reverse

The reverse effect processes the selected region in such a manner that it will be played

backwards.

6.3 Using Audio Plug-Ins

Acoustica 4 supports DirectX as well as VST plug-ins. Both formats have become widely

used standards for audio processing plug-ins on the Windows platform. The menu 

Plug-Ins contains a list of the plug-ins currently installed on your computer. If you have

installed a plug-in that does not appear in the list, please refresh the plug in list (see 

Refreshing the Plug-in List). Using DirectX or VST plug-ins is as easy as using the

internal audio processing tools.  You will see that previewing works exactly the same

way as with the internal audio processing tools.

6.3.1 Refreshing the Plug-in List

If you have installed new DirectX or VST plug-ins on your computer that do not appear

in the Plug-Ins menu you should refresh the menu by selecting Plug-Ins | Refresh Plug-In

List. Acoustica then rescans the plug-ins on your computer and updates the menu.

6.3.2 Specifying VST Directories

VST plug-ins are not registered on your computer like DirectX plug-in, hence Acoustica

needs to know where to find them. You can specify one or more directories to scan

through.

The VST Directories dialog lets you specify one or more VST directories to scan through.

To add a new entry, click the add directory button [  ]. You can edit a directory entry

by double clicking with the left mouse button. Delete an entry by clicking the delete
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button [  ].

6.4 Noise Reduction

Acoustica provides tools for removal of both stationary noise such as hiss and impulsive

noise like clicks and pops. The frequency spectrum of stationary signals remain pretty

constant over time. In other words, tape hiss, humming or other constant disturbances

are removable using the Acoustica noise reduction system. The noise reduction is based

on the spectral subtraction technique. This means that a spectrum of the noise present in

the recording is needed. Acoustica can automatically estimate the noise profile or the

spectrum of the noise can be obtained through analysis of a region containing noise

only. Alternativly, the user can define the noise profile manually.

· Automatic Noise Reduction

· Removing Noise with a Measured Profile

· Removing Noise with a User Drawn Profile

Impulsive noise on the other hand consists of short unpredictable noise burst. It has

become usual to define clicks as single noise bursts, whereas crackle is defined as a

series of very short clicks with low amplitude. Acoustica is able to remove impulse noise

due to the short duration of the noise bursts. Acoustica substitutes the recorded signal in

the short period of time during the click with a signal estimated using the undistorted

audio surrounding each clip.

You can remove clicks either automatically or manually:

· Automated Click Removal

· Manual Click Removal

6.4.1 Automatic Noise Reduction

The easiest way of removing stationary noise is to use the automatic noise reduction.

Select Enhancement | Automatic Noise Reduction... Acoustica then performs a statistical

analysis of recording in order to estimate the noise profile. This process might take a

little while, depending on the length of your recording. After the analysis phase, the

noise reduction window appear:
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The Noise Reduction settings. The noise profile graph contains the result of the noise analysis.

There are two parameters you can adjust:

· Reduction factor scales the noise profile obtained in the analysis phase and allows

you to remove more (positiv values) or less (negative values) noise than the analysis

algorithm detected.

· Max. attenuation allows you to adjust a maximum attenuation factor for each

frequency component. This parameter is also referred to as noise floor. By leaving a

certain noise floor, you can mask annoying artifacts from the noise reduction

algorithm.

Initially, you cannot edit the noise profile graph after the noise analysis. If you want to

edit the result:

· Click the button labelled Edit Curve

· The number of points in the curve is reduced and you can add, move or remove the

curve points.

6.4.2 Removing Noise with a Measured Profile

If your recording contains pauses with pure noise without any other signal, the pause

can be used to create a noise profile automatically. Select Enhancement | Noise Analysis...

after selecting the region containing noise only. After the analysis phase, select 

Enhancement | Noise Reduction... The result of the analysis is automatically loaded in

the profile graph.
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The Noise Reduction settings. The noise profile graph contains the result of the noise analysis.

Apart from the analysis method, the noise reduction algorithm is exactly the same as

with the automatic noise reduction. Hence, the parameter settings have the same

meaning.

6.4.3 Removing Noise with a User Drawn Profile

If no pauses are available for noise analysis you can draw a noise profile by hand. Select 

Enhancement | Noise Reduction. A curve editor shows up where you can manually enter a

noise profile.

Note If you performed noise analysis in a previous editing step, you will need to

reset the curve by selecting Reset from the preset list.

For tape hiss this method works quite well. The tape noise is more or less evenly

distributed in the spectrum, thus a flat line should to the job. Finding the right threshold

can be tricky, but after a bit of try and fail, good sounding settings should be possible to

find.
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The Noise Reduction settings with a manually drawn noise profile.

6.4.4 Automated Click Removal

The declicker is a specialized tool for removing impulsive noise such as clicks and

crackle. It is based on two algorithms, one that targets rare but loud clicks, and one that

targets very short and frequent clicks referred to as crackle.

The Declicker settings

Settings
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· Click Reduction

Sets the sensitivity of the click filter. Higher reduction levels result in more click

reduction.

· Click length

The maximal length of the clicks that are to be removed.

· Crackle Reduction

Sets the sensitivity of the crackle filter. Higher reduction levels result in more crackle

reduction.

Optionally, clicks may be removed manually by selecting one single click and using the 

Interpolate command in the Enhancement menu.

6.4.5 Manual Click Removal

You can remove clicks manually be selecting the smallest region which fully includes

the complete click and then select Interpolate from the Enhancement menu or press Ctrl+I.

Acoustica substitutes the region with an estimate of the signal without the click.

Note Interpolation is only possible on short regions. If the selected region is too

long, the Interpolate command is grayed out.

6.5 Enhancement Tools

6.5.1 Declipper

The declipper restores audio recordings distorted by clipping. Clipping occurs during

recording when the recording level is too high and the highest peaks cannot be correctly

recorded. The declipper substitutes such distorted peaks by an estimation of the signal

curve using almost the same mathematical methods as the declicker when eliminating

clicks.
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The Declipper settings

The most important parameter of the declipper is the threshold level. The declipper will

substitute all recorded peaks louder than the threshold value. Furthermore, the input

gain of the declipper can be adjusted. That is helpful if the signal level is so high that the

restored clips get louder the maximum signal level range.

Settings

· Threshold

All sample values louder than the threshold are substituted by a signal estimation.

· Input gain

The input gain is useful for adjusting the signal level before declipping.

6.5.2 Equalizer

About Equalizers

Equalizers are devices that allow frequency dependent volume changes. In home stereo

gear they would be comparable to bass and treble controls, except that equalizers are

more highly specialized for adjusting and fine-tuning the frequency spectrum amplitude

in audio material. A parametric equalizer consists of filters with variable center

frequencies and adjustable bandwidths, as opposed to graphic equalizers where the

center frequencies and bandwidths are fixed.

User Interface
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The Equalizer settings

Parameter Settings

Each band can be set to one of the following filter types:

· Peak filter

The peak filter increases or decreases the level of the frequency band surrounding

the center frequency.

· Low shelving filter

The low shelving filter increases or decreases the level of the frequencies below the

cutoff frequency.

· High shelving filter

The high shelving filter increases or decreases the level of the frequencies above the

cutoff frequency.

· High pass filter
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The high pass filter removes frequencies below the cutoff frequency.

· Notch filter

The notch filter removes frequencies surrounding the center frequency.

· Low pass filter

The low pass filter removes frequencies above the cutoff frequency.

Each band has a gain and a bandwidth parameter in addition to the center frequency

and the filter type. The gain specifies the volume or level of the frequency band. If the

gain is set to 0 dB, there will be no change in level compared to the original input. By

selecting a positive gain, the frequency band is boosted. A negative gain leads to an

attenuation of the frequency band. The bandwidth parameter is of use only when the

filter type is set to peak filter. The bandwidth is specified in octaves, whereas one octave

band equals the frequency range of one octave on the piano keyboard.

· Frequency response graph

The frequency response graph visualizes the frequency response of current equalizer

settings. The visualization is calculated mathematically and updated as the

parameters are changed.

Each of six equalizer bands is visualized with a small circle containing the number of

the band. You can select a band by clicking its corresponding circle. By keeping the

mouse button down while moving the mouse cursor, you can change the gain and

the center frequency of the bands. The numbered circle affected by any changes to

the settings is highlighted as shown above. In the example, band three is the one

affected by any changes made.

· Gain slider

You can also use the gain slider to adjust the gain of the currently selected band. The

gain can be set to a value between -15 and +15 dB.

· Frequency knob

The frequency knob lets you set the center frequency (for peak filters) or cutoff

frequency (for shelving filters) of the selected band. To enter the frequency

numerically, click the frequency knob and tap the space bar.

· Bandwidth knob

The bandwidth knob lets you set the bandwidth of the selected band. The bandwidth

determines the width of the frequency band surrounding the center frequency in a

peak filter. The bandwidth has no effect on shelving filters.

· Filter type (Low shelving, peak, high shelving, high pass, notch and low pass)
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You can set the desired filter type for the selected band with these radio buttons. As

with other standard radio buttons, selecting one deselects any others.

· Master gain

The master gain is the master volume for the audio being equalized and is frequency

independent. You can adjust the volume using the master gain slider if the overall

output level is too high or too low. This lets you compensate for the changes in level

that can result from large changes made in the frequency response curve using the

equalizer, particularly in the lower frequencies.

6.5.3 High Frequency Synthesis

Dull and lifeless recordings may be a result of lost high frequency content. By using the 

High Frequency Synthesis tool (select Enhancement | High Frequency Synthesis...), you can

add artificially created harmonics to brighten up the recording. Note that these are

merely synthetic harmonics based on the low frequent content of the recording and this

feature can only be used give the listener the impression of stronger harmonics.

The High Frequency Synthesis settings

Settings 

· Generate above

Specifies the lower limit of the frequency band where harmonics should be

synthesized. 

· Add content / Replace content

If add content is selected, the original content in the synthesis frequency band is

mixed with the synthesized harmonics. If you choose replace, Acoustica removes the

original content before adding the synthesized harmonics.

· Dry level
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The amount of unprocessed signal in the output mix.

· High frequency level

The amount of processed signal in the output mix.

6.5.4 Stereo Enhancer

The Stereo Enhancer enhances the stereo image by filtering the left and the right

differently. The filters are designed to maintain mono compatibility.

The Stereo Enhancer settings

Settings 

· Stereo Depth

Sets the amount of stereo enhancement from 0 (no enhancement) to 100% (maximum

enhancement).

6.5.5 Remove DC Offset

Wrongly calibrated recording equipment may result in a signal that is not centered

around zero as it should be. The Remove DC Offset tool (select Enhancement | Remove DC

Offset) calculates the DC offset of the selected region and subtracts the offset if necessary.

6.5.6 Phono Filter

The phono filter emulates the effect of a phono preamplifier (deemphasis filter) or the

opposite process applied when creating a master record (emphasis filter). In some cases,

you can achieve better results from the declicker if you record an LP without the

emulation of a phono preamplifier, apply the declicker and then apply the phono filter.

You can post process any recording originating from an LP this way by first applying

the emphasis filter, perform declicking and apply the deemphasis filter.
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The Phono Filter settings

Settings

· Emphasis or deemphasis mode

Choose deemphasis mode if you have a recorded an LP record without phono

preamplifier.

6.6 Converting the Sample Format

You can change the sample format of an audio recording by selecting Sound | Convert

Sample Format... If you are not familiar with the terms sample rate or resolution, please

read Concepts of Digital Audio before proceeding.

To convert the sample format of a recording, select Sound | Convert Sample Format... A

dialog box appears where you can define the sample rate, resolution and the number of

channels in the new sample format. Click the button labelled Ok when you are done.

The Convert Sample Format dialog box
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6.7 Effect Chains

The effect chain editor allows you to link effects, processing tools, VST and DirectX

plug-ins. The chains can be saved including the settings of the effects for later use.

Furthermore, each element can easily be bypassed and the order of the elements

changed using drag and drop.

The effect chain editor in Acoustica.

Adding Effects to the Chain

To add a new effect to the chain, click the add effect button [ ]. A browser window

appears where you can select the effect, plug-in or processing tool you want to add to

the chain.

Removing Effects from the Chain

To remove an effect, select the effect you wish to remove and click the remove button [ 

 ].

Editing the Effect Settings of an Element in the Chain

To open the effect settings window of an element in the chain, double click its entry in

the list.

Playing the Audio Processed by the Effect Chain

You can play audio processed by the effect chain if you have an open editing window.

Select the region you want to play in the editing window and click the play button [  ].

The selection will be played looped. You can stop the playback by clicking the stop

button [  ].

Bypassing an Element

You can bypass an element by clicking the checkmark left to the effect entry in the list.

Saving and Loading Effect Chains

You can store a complete effect chain including all parameter settings for later use. To

store the effect chain, click the save button [  ]. A standard file save dialog box appears

where you can enter the file name. To open an effect, click the load chain button [  ]
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and select the file in the file browser.

7 Working with Audio CDs

You can create Audio CDs (see Creating Audio CDs) that you can play in normal CD

players directly within Acoustica if you have a supported CD burner. Furthermore,

Acoustica allows you to import audio tracks from existing CDs digitally and without

quality loss for further editing or archiving on the computer (see Importing Audio

Tracks from CDs).

7.1 Creating Audio CDs

Acoustica allows you to create audio CDs containing your edited recordings. The first

step towards your own CD is to create a CD-Project by selecting File | New | CD

Project… or by clicking the new button and select CD Project… from the drop-down list.

The CD Project contains a list of the audio tracks to be written on the CD and an

additional toolbar for commands related to the CD Project.

An empty CD Project window

The CD Project window contains a list of the audio tracks to be written to the audio CD.

You can add either

· existing audio files - or -
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· the content of an editing window

as a separate tracks in the track list of the CD project.

7.1.1 Adding an Existing Audio File

You can add an existing audio file to the CD project by clicking the import audio file

button (  ) or using drag and drop from the Windows Explorer. If you click the import

button, a standard file open dialog box appears (see Loading Audio Files) where you can

selected the audio file or files you wish to add to the CD project.

7.1.2 Adding the Content of an Editing Window

The content (or parts of the content) of an editing window can be added as a track in the

CD project without first creating an audio file:

1. Select the region in the editing window you wish to add as an audio track on the

CD.

2. Click the left mouse button anywhere on the highlighted area and keep the mouse

button down.

3. Move the mouse cursor to the track list in the CD project window.

4. Release the mouse button.

7.1.3 Burning the CD

When you are finished assembling your CD project, click the button labelled Burn CD

from the toolbar of the CD Project window. The CD Burner dialog appears:
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The CD burner dialog allows you to select a CD recording device, recording speed and the

number of copies.

Insert a blank CD into the CD recording device. If you have several CD recording

devices installed on your computer, make sure you choose the correct one from the CD

Recording Device list. You can choose among different recording speeds and set the

number of copies to burn. It is recommended to keep the Enable buffer protection option

enabled, if supported (if not, the check box appears inactive). Click the button labelled 

Burn to start burning.

7.2 Importing Audio Tracks from CDs

It is possible to digitally import audio data from audio CDs with most CD-ROM readers.

Acoustica will import title and artist information if available as CD-TEXT. If no

CD-TEXT is available, you can perform an internet look-up in the FreeDB data base.

To import one or more audio tracks:

1. Select Import Tracks from Audio CD... from the File menu. If the CD doesn't contain

any CD-TEXT information, you will be asked if you want Acoustica to look for artist

and title information in the FreeDB data base on the Internet. If you choose no, the 

CD Track Extraction dialog box appears immediately. If you choose yes, there might

be several entries matching your CD. Please choose the correct album from the list

and choose OK.

2. If you have several CD-ROM devices installed, please make sure that the device that

contains your source audio CD is selected in the CD-ROM Device drop-down list.

3. Select the track or the tracks you wish to import from the track list.



67Working with Audio CDs

Copyright © 2013 Acon AS

4. Click the button labelled Extract.

The CD Track Extraction dialog box

The imported audio tracks appear as separate editing windows in the Acoustica

workspace.

Adding Track Titles and Album Information Manually

If there is no FreeDB entry available for your CD you want to modify the information,

you can do this manually in the CD Track Extraction dialog. To rename a track title,

double click the track entry in the list or press F2. A dialog box appears where you can

enter the new track name.

The album information can be changed directly with the edit boxes in the Album

Information group box.
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Note You can listen to the content of a track by clicking the button labelled Preview

8 Using the Cleaning Wizard

If you are new to digital audio recording, the Cleaning Wizard simplifies LP or cassette

to CD transfers by guiding you through all the steps from recordings, track splitting,

restoration and CD burning. To open the Cleaning Wizard, select File | Cleaning Wizard...

and the following window appears:

The Cleaning Wizard window

Note The Cleaning Wizard leads you step by step through the process of

transferring your analog audio to CD. However, if you can choose to go back

to an earlier step or skip one or more steps at any time by clicking at the 

Import, Restoration or Export tabs at the top of the wizard.

8.1 The Import Page

The import page is the first step in the Cleaning Wizard. From here you can choose to

record an LP, record a cassette, import an audio file or get help about connecting your

audio equipment. Click on one of the options to proceed.



69Using the Cleaning Wizard

Copyright © 2013 Acon AS

8.1.1 Record Audio

If you choose to record from either LP or cassette the Cleaning Wizard will proceed to

the recording page:

The recording page in Acoustica 4.

The input level meter (2) shows the current input level. If you have connected your

audio equipment and started playback, the meter should show a constantly changing

input level. If the level is low and not changing, there is probably something wrong with

the connection or the wrong input line is selected. You can usually choose between

several different input lines, like microphone or line in. The Cleaning Wizard tries to set

Line In as input line automatically, however, you should check the input line setting (1)

before proceeding. If you are uncertain, please try through the options and see if there is

any response on the input level meter (2).

Recording Step by Step

1. Make sure your audio equipment is properly connected to your computer

2. Check that the input line (1) is correctly set. In most cases, the line input should be

set to Line In

3. Check that the input level is in the correct range. You can use easily check the input

level using input level meter (2). You can adjust the input level using the input level

slider (3). The meter should never go up to 0 dB, otherwise digital clipping will be

introduced. Check with the loudest part of the record or cassette tape you are
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recording that the input level meter doesn't go higher than about -6 dB.

4. Click the button labelled Record (4) to start the recording.

5. Press play on your tape deck or record player.

6. Press the Next button in the lower right part of the Cleaning Wizard when you have

recorded the whole record or cassette tape.

Note The recording page has several advanced features not mentioned here.

Please see the chapter Recording through the Sound Card for more details

about the advanced features such as timer record, digital monitoring and DC

offset correction.

8.1.2 Import Files

If you choose to import an existing audio file, a file browser window appears where you

can select the audio file you want to open.

The File Import page in the Cleaning Wizard.

To import an audio file, please do the following:

1. Choose the folder in which your file is located from the Look in drop-down list.  

2. Click the audio file you wish to open and click the button labelled Next.
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8.2 The Restoration Page

The Restoration Page allows you to adjust the settings of the audio restoration tools and

split the recording into several tracks.

The Restoration Page contains a waveform view of the recording and list of the tracks, as well as

audio restoration and processing options.

1. The waveform view shows you a graphical representation of the recording. Tracks

are indicated with a different color.

2. The transport bar allows you to control playback.

3. The track list shows you the tracks defined. The Cleaning Wizard automatically

suggests tracks, however, you can easily add, move or remove track markers.

4. The audio restoration tools, declicker, decrackler, declipper and denoiser. You can

adjust the amount of restoration using the sliders and activate or deactivate a tool

using the on / off buttons.

5. You can add further effects and processing tools, like equalizing or reverb. You can

choose among all the internal tools and effects as well as VST and DirectX plug-ins.

8.2.1 Track Splitting

The Cleaning Wizard automatically searches for pauses and suggests tracks when

recording or importing audio files. However, if the recording is very noise or tracks are

blended seamlessly into each other, the tracks suggested by the Cleaning Wizard might

not be identical to the original tracks on the source record or cassette.

Changing the Region of an Existing Track

1. Move the mouse cursor to the beginning or the ending of a track. The mouse cursor

turns into a left-right arrow.
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2. Keep the left mouse button pressed while moving the mouse cursor to the new

position.

3. Release the mouse button.

Adding a track

1. Move the mouse cursor the beginning of the track you want to add in the waveform

view.

2. Keep the left mouse button pressed while moving the mouse cursor to the end of the

track.

3. Release the mouse button.

4. Click the button labelled Add Track.

Removing a Track

1. Click the track you want to remove in the track list.

2. Press the Delete key on your keyboard.

Renaming a Track

1. Click the track you want to rename in the track list.

2. Wait more than two seconds without moving the mouse cursor or press the F2 key

on your keyboard.

3. The entry in the track list turns into an edit box. Enter the new name of the track.

8.2.2 Restoration

There are four restoration tools integrated into the Cleaning Wizard:

· Declicker

Removes loud clicks and pops.

· Decrackler

Removes short but frequent clicks, referred to as crackle.

· Declipper

Restores recordings that suffer from analog or digital clipping.

· Denoiser

Removes static noise like tape hiss.
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The restoration tools in the Cleaning Wizard

You can adjust the effect of each tool by moving the sliders in the range from 0% (no

effect) to 100% (full effect). Furthermore, each tool can be activated or deactivated by

clicking the on / off button left to the slider.

Playing Restored Tracks

The restoration tools in the Cleaning Wizard are processed in real time during playback

so that you can listen to the effect of different restoration settings during playback. You

can control the playback from the transport buttons in the Restoration Page:

The transport button bar in the Restoration Page gives you full control over the audio playback.

Start the playback by clicking the play button (1). The playback will start from the

current cursor position in the waveform. You can also use the play all button (2) to play

the complete recording. Stop the playback by clicking the stop button (3).

8.2.3 Further Editing and Processing

The Restoration Page in the Cleaning Wizard also lets you add further effects (or

processing tools) to the recording. You can choose among all the internal effects as well

as VST or DirectX effects. When you play the recording in the Restoration Page, the

effects are processed in real time so that you can check the results immediately.

Adding Further Effects

1. Click the button labelled Add Effect below the additional effects list.

2. Select the effect you want to add to the effects list.

Editing the Effect Parameters

1. Double click the effect in the additional effects list.

2. The effect settings page is shown.

3. Make your changes and close the window when done.
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Removing an Effect from the List

1. Click the effect you want to remove.

2. Press the Delete button.

8.3 The Export Page

You can export your cleaned up tracks to audio files or burn them directly on a CD.

Please choose one of the two.

8.3.1 Burn a CD

If you choose to burn a CD, the CD Burner dialog appears:

The CD burner dialog allows you to select a CD recording device, recording speed and the

number of copies.

Insert a blank CD into the CD recording device. If you have several CD recording

devices installed on your computer, make sure you choose the correct one from the CD

Recording Device list. You can choose among different recording speeds and set the

number of copies to burn. It is recommended to keep the Enable buffer protection option

enabled, if supported (if not, the check box appears inactive). Click the button labelled 

Burn to start burning.
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8.3.2 Export to Audio Files

If you choose to export your tracks to audio files, the File Export Page appears:

The File Export Page in the Cleaning Wizard

You can choose a destination directory for your tracks (1), an album name (2) and the file

format of the exported tracks (3). During the export, an directory will be created with the

album name and the tracks are written to audio files with the name of the tracks within

the album directory.

9 Using the Batch Processing Wizard

The Batch Processing Wizard in Acoustica 4 allows you to convert and processed a large

number of files without user interaction. Even complete directory stuctures can be

processed at once. To start the Batch Processing Wizard, select File | Batch Processing

Wizard..., and a the Batch Processing Wizard appears on your screen as depicted below.
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The Batch Processing Wizard window.

9.1 Adding Source Files

The first step of the Batch Processing Wizard is to add the source files. The most straigt

forward way to add files is to click the button labelled "Add files". A standard file open

dialog opens where you can browse and choose one or more files to open. You can

repeat this procedure if you wish to add files from several folders.

The source files can be arranged in folders or you can choose to import complete folder

structures.

Note You can listen to the imported files by clicking the preview button below the

file list. Click the stop button to stop previewing.

9.1.1 Importing Folders

To import the complete content of a folder, click the button labelled "Add folder". The

following dialog box appears:
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The import folder dialog box allows you to import complete folder structures.

Use the folder browser to select the folder you wish to import. You can choose to import

only the content of the selected folder or the whole folder structure by clicking the check

box "Include subdirectories".

The "Import files of type" drop down list lets you reduce the files to all known file

formats or a specific file format only.

9.1.2 Creating Folders

You can also create target folder structures manually by clicking the "Create folder"

button. A dialog box appears where you can enter the name of the new folder.

9.1.3 Removing an Item

You can remove an item (file or folder) by selecting the item and clicking the button

labelled "Remove item".



78 Acoustica User Guide

Copyright © 2013 Acon AS

9.2 The Target Files Page

When you have added all the files you wish to convert or process you can proceed to the

"Target Files" page by clicking the "Next" button or the "Target Files" tab. The following

page appaers:

The Target Files page of the Batch Processing Wizard.

Note You can choose to start processing from the Target Files page any time by

clicking the button labelled "Start" below the Target Files page.

9.2.1 Adding Processing Tools

The Batch Processing Wizard lets you process the files with internal tools and effects as

well as VST and DirectX plug-ins. The "Processing Tools & Effects" section of the Target

Files page contains a list of the processing tools that are to be used when processing the

files.

To add a processing tool, click the button labelled "Add". The "Processing Tools

Browser" appears from which you can select the effect, processing tool or plug-in you

wish to add to the list.
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The Processing Tools Browser lets you select an internal processing tool or a plug-in.

When you have selected the processing tool, click the button labelled "Add".

You can change the parameter settings of a processing tool by clicking the "Edit" button

or by double clicking an item in the Processing Tools & Effects list.

To remove a processing tool from the list, click the processing tool to highlight it and

click the "Remove" button.

Loading Effect Chain Files

The Batch Processing Wizard is able to import complete effect chains created by the

effect chainer in Acoustica or the Acon Digital EffectChainer. To load an effect chain file,

click the "Load chain" button. A standard file open dialog box appears where you can

select the effect chain file you wish to load.

9.2.2 Defining File and Sample Format

The "File & Sample Format" section of the Target Files page lets you select an output file

format. To set the output file format you can simply choose the output format from the

file type drop-down list. If the file format offers custom parameters settings, like

encoding bitrate for mp3 files, you can edit theese settings by clicking the button

labelled "Options" next to the file type drop-down list.

Furthermore, you can define the sample rate, number of channels and resolution of the
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target files. If you convert high resolution audio files to a lower resolution, you can

optionally apply dithering and noise shaping.

9.2.3 Specifying the Target Folder

The last section of the Target Files page lets you select an output folder. You can either

enter a folder path in the edit box or click the button labelled "Browse" to select a folder

from the folder structure of your computer.

10 Audio Analysis

Acoustica features a range of tools that allows you to study your recorded material in

the time domain (see Time Domain), frequency domain (see Frequency Domain) or a

combination of these (see Combining Time and Frequency).

10.1 Time Domain

The normal wave plot shown when making a recording in Acoustica is a time domain

representation of the signal. When recording, Acoustica has taken samples of the signal

at certain intervals, quantized them, and stored them as series of digitized values. The

wave plot is the result of drawing these samples on the screen with the time evolving

along the horizontal axis.

A plot of a signal represented in the time domain

10.2 Frequency Domain

All natural sounds can be described as an infinite sum of sine functions. The frequency

of a sine function is related to what we sense as pitch. Our ears are not able to hear

frequencies above 20kHz (a sine function with 20 thousand completed wavelengths

within one second), so the mentioned infinite sum turns into a finite sum which is
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possible to handle on a computer. The signal in the frequency domain is represented

through the weight of each sine function needed to recreate the signal, rather than the

sampled values from the time series. These weights are visualized in Acoustica by

selecting Analysis | Spectrum Analyzer. 

 A plot of a signal represented in the frequency domain. 

10.3 Combining Time and Frequency

We have a tool for examining the frequency content (the spectrum) of our recording and

we have the normal wave plots for examining how our recording evolves over time. Is

there a possibility to combine these features, in order to study how the frequency

content evolves over a period of time? Actually, Acoustica features two ways of

displaying so called time-frequency plots. The spectrogram and the wavelet transform

(based on the Morlet class of wavelets for the advanced reader). They differ mainly in

the frequency scale. The spectrogram has a linear frequency scale whereas the wavelet

transform has a logarithmic frequency scale. 

A spectrogram generated by Acoustica. The vertical axis represents the frequency, the horizontal

represents time.
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You can adjust the resolution and the color representation in both the spectrogram and

the wavelet transform in the Preferences dialog box (see Changing the Preferences).

11 Preferences and Device Settings

11.1 Device Settings

Window's multimedia system allows several different audio cards being installed at the

same time. You can select which sound card to use by selecting Device Settings... from

the Options menu. Choose input and output devices from the drop-down lists in the

device settings dialog to change the current configuration and click the button labelled 

Ok.

11.2 Changing the Preferences

You can set your personal preferences with the command Preferences... in the Options

menu.

The Preferences dialog box

The preferences are organized in different pages. Only one page is shown at a time and

you can show another page by clicking the tabs in the upper part of the dialog box. The

following pages are available:

· Directories

· Spectrogram
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· Wavelet Transform

11.2.1 The Directories Page

The Directories page contains only one setting, the directory for all temporary files

created by Acoustica. You should set this directory path to a directory on a fast hard disk

with sufficient free space. Acoustica works extensively with temporary files and the

speed of the programs depends to a large degree on the speed of the hard disk where

the temporary files are situated.

The directories preferences page
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